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This job aid is available online: 
• In the Public Folders: 

All Public Folders > Statewide > Connections > Build 15 

• On the CONNECTIONS Intranet site: 
DFA Intranet Site > OCFS Homepage > Connections > Desk and Job Aids 

The CONNECTIONS Intranet site also contains information about CONNECTIONS training. 

 

Note: Any visible identifying data in this job aid is simulated. 

 
 

New Phone Number for the CONNECTIONS Help Desk 
CONNECTIONS Help Desk staff are available to answer basic questions related 
to your equipment or problems you’re having with the CONNECTIONS 
application. If they cannot solve the problem, they will record your information 
and forward it to others who can. 

When you call the Help Desk with a problem, you will receive a ticket number to 
use for tracking your issue and its resolution. Keep a record of this number; you 
will need it for any follow-up conversations with the Help Desk. 

The Help Desk is staffed 24 hours a day, seven days a week. The new telephone 
number is: 

1-800-NYS-1323 
(1-800-697-1323) 
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Introduction 

This Job Aid provides information about the changes to FAD and Common Functions in 
CONNECTIONS that are being introduced with Build 15. 

Specifically, this Job Aid contains information about: 

• Changes to several windows in the FAD dialog. 

• Enhancements to streamline the FAD home creation, maintenance and documentation 
process. 

• New system capabilities for modifying the Legal Name of a FAD home. 

• Restrictions requiring supervisory approval when a change to resource (FAD home) 
name or address has been recorded. 

• New system capabilities for documenting home closures. 

• Modifications to recording capabilities for homes in Emergency status. 

• Additional system alerts for home certification/approval extensions and expirations. 

• New system capabilities for documenting status and extensions for fingerprint results 
and medical reports. 

• System edits to identify appropriate relationships between Setting and Program Type. 

• System edits requiring the recording of person demographic information and required 
dates for medical and fingerprinting information. 

• System edits for the recording and identification of foster parents. 

• New system messages for errors in the FAD recording/certification process. 

• Changes to F/A Home Search, Resource Search and Person Search. 

• New system capabilities for recording the removal of a person from a FAD home. 

• Implementation of the new Foster and Adoptive Home Record Summary (FRS). 
Information regarding the FRS is detailed in the Foster and Adoptive Record Summary 
(FRS) Job Aid. Features of the FRS include: 

⇒ A comprehensive view of FAD information recorded in CONNECTIONS, including 
home demographics, person detail and licensing information. 
 

⇒ A single, multi-tabbed window that enables workers to access, view and print FAD 
home information easily. The window is organized to be consistent with the 
foster/adoptive home development process. 
 

⇒ Functionality for recording comments and contact notes at appropriate points 
throughout the process. 
 

⇒ Mechanisms for recording FAD Home Study narratives and Annual Reauthorization 
narratives. OCFS templates are provided for recording these narratives in the FRS. 
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⇒ Reduction of duplicate information entry in external notes documents and 
CONNECTIONS. This results in a more complete, online record for each home and 
an improvement in the quality of case record documentation for FAD homes. 
 

⇒ An updateable FAD checklist that assists workers in verifying that all tasks 
necessary for proper certification/approval of FAD homes are completed. 
 

⇒ A Contacts tab, which provides a place for workers to record all contacts made for a 
FAD home, creating a contemporaneous document of the FAD home development 
process. 
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Changes to FAD Windows 

In addition to the specific changes detailed in this section, Build 15 includes the addition of 
appropriate system identifiers (e.g., Stage Name, Resource ID, Case ID) in the title bar on FAD 
windows. 

Task List 
The Task List guides a FAD worker through the pre-defined activities (based on policy and 
procedure) for a FAD home. 

 
 
Build 15 includes several changes to the Task List for FAD stages: 

• Three new tasks have been added to the Task List: 

⇒ Home Study 
⇒ Annual Reauthorization (replaces the previous Authorization task) 
⇒ View FAD Record Summary 

 
A fourth new task, Vacancy Control Bed Maintenance, will be implemented this 
summer. 

The Home Study, Annual Reauthorization and View FAD Record Summary tasks 
navigate directly to the FAD Record Summary (see the FAD Record Summary Job Aid 
for details). The Vacancy Control Bed Maintenance task navigates directly to the 
Vacancy Control application (see the Vacancy Control Job Aid [coming Summer 2002] 
for details). 

• When a worker selects the Maintain Person task, only the List… button enables; the 
New button remains disabled. (Prior to Build 15, both the New and List… buttons 
enabled when the task was selected, but clicking either button opened the Person List 
for the selected FAD home.) 
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• A new button (Use Prior…) has been added for use with the Home Study and Annual 
Reauthorization tasks. This button opens the FAD Record Summary and retrieves the 
most recently saved and approved narrative in a “new using” format. 

The Use Prior… button enables a FAD worker to use the previously recorded Home Study or 
Annual Reauthorization document as the foundation for a new Home Study or Annual 
Reauthorization document. 

The Use Prior… button enables only if the Home Study or Annual Reauthorization task is 
selected and a previously saved version of the Home Study or Annual Reauthorization 
document exists, as applicable. The button is disabled if the Annual Reauthorization task is 
selected and the date is not within 90 days of the reauthorization due date. 

For a home with a previously saved FAD Record Summary, click on the Home Study or Annual 
Reauthorization task, as appropriate, and click on the New button. The following message 
displays: 

“Option selected will start with new (i.e., blank) narratives instead of the last saved narratives.” 

The worker clicks on the Continue button to retrieve the FAD Record Summary with blank 
narratives. The Cancel button enables the worker to select the Use Prior… button to retrieve 
the most recent previously saved narratives. Guidelines for recording MAPP/GPS and OCFS 
Standard home study narratives will be available in the near future via the CONNECTIONS 
Online Help function. 

 

Case (Stage) Name/CD 

 
Formerly titled Change Case Name, this window has been renamed as Case (Stage) Name/CD. 
It allows an authorized worker to change the name of a FAD home. Whenever the name of a 
FAD home is changed, the Resource (Home) Name and Legal Name are automatically updated 
as well. For most FAD homes, the Resource Name and the Legal Name are the same. 

New York City addresses are organized into geographical subdivisions called Community 
Districts (CDs). FAD workers in New York City will see Community District (CD) information in 
FAD windows that contain a CD field or column. The CD field on the Case (Stage) Name/CD 
window is pre-filled with resource address information recorded in CONNECTIONS; the CD 
cannot be changed on this window. 

In order to open the Case (Stage) Name/CD window from the Assigned Workload and make 
changes, you must be: 
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• a Primary or Secondary worker assigned to the home; 

• the assigned worker’s supervisor; or 

• in the assigned worker’s Unit hierarchy. 
 

To Access the Case (Stage) Name/CD Window from the Assigned Workload: 

1. Select a home from the Assigned Workload. 

2. Click on the Options menu and select the Case/Stage Name command. 
 

For homes in Accepted-Active or Emergency status, changes to the Case (Stage) Name/CD 
window must be Saved and Submitted. If you click on the Save button (or select the Save 
command from the File menu), the following message displays: 

“Supervisory approval is required for this action. Select Save and Submit.” 
 

When you select the Save and Submit command from the File menu, the following message 
displays: 

“This change will also update the Resource Legal Name.” 
 

A Task To-Do is created for the approver, who navigates to the Case (Stage) Name/CD window 
from the Task To-Do on the Staff To-Do List. A new home event is created on the Event List 
when the Case (Stage) Name/CD window is Saved (or Saved and Submitted). 

When a home’s name is changed and submitted for supervisory approval, CONNECTIONS 
sends an Alert To-Do to the primary worker’s Staff To-Do List. The text of the To-Do reads: 

“Update Home Study/Reauthorization RE: Address/Name change.” 
 

If the Legal Name of the FAD home should be different than the new Resource Name, the 
worker needs to change the Legal Name in the Home Demographics window after the Home 
Name change is approved by the supervisor (see page 25 for information about changing the 
Legal Name of a FAD home in the Home Demographics window). 

Home Name changes for FAD homes in Accepted-Active or Emergency status must be Saved 
and Submitted. Homes in any other status must be Saved. 

The following message displays when you Save (or Save and Submit) changes to the Case 
(Stage) Name/CD window: 

“This change will also update the Resource Legal Name.” 
 

If the worker navigates to the Case (Stage) Name/CD window when a Home License or Home 
Closure pending approval event exists, the window can be opened only in View-only mode. The 
following message displays: 

“The home/facility is Pending Approval or Pending Closure. Changes are not allowed.” 
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If the worker navigates to the Case (Stage) Name/CD window when a Home Name change is 
pending approval, the following message displays: 

 “Saving will invalidate the Pending approval. Continue in Modify mode?” 
 

Clicking on the No button opens the Case (Stage) Name/CD window in View-only mode. 
Clicking on the Yes button opens the window in Modify mode. Opening the Case (Stage) 
Name/CD window in View-only mode allows workers to view information; Modify mode allows 
workers to change the Case/Stage/Home name of a home (see the table below for details 
regarding View-only and Modify mode). 

If the supervisor rejects a name change, the home’s original name will be restored to the last 
approved value. 

View-only vs. Modify Mode 

View-only Mode Modify Mode 
 

• The Current Name and 
Current CD fields are 
protected (information 
cannot be changed). 

• The New Name and New 
CD fields are disabled. 

• The Save command (File 
menu) and button are 
disabled and all fields are 
protected. 

• The Save and Submit 
command (File menu) is 
also disabled. 

• Only the Cancel button and 
the Exit command (File 
menu) are enabled. 

 

• The Current Name and Current CD fields are 
protected. 

• The New Name field is modifiable. 
• The Save command (File menu) and button 

enable when the New Name field is populated 
with a different name than the Current Name 
field. 

• The New CD field is disabled (CD information 
cannot be changed in this window). 

• The Save and Submit command (File menu) 
enables only when the stage type is FAD and 
the home is in Accepted-Active or Emergency 
status and the New Name field is populated 
with a different name than that of the Current 
Name field. 

• The Cancel button is enabled. 
 

The table starting on page 10 explains the display variations for the Case (Stage) Name/CD 
window. 
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Case (Stage) Name/CD Window 
Display Variations 

Path/ 
Window 

Display 
Mode 

Display 
Details 

Assigned 
Workload 

View-only 
or 

Modify 

• The Current Name field displays the current 
case/stage/home name for the selected FAD home 
and the Current CD field displays the current CD for 
the selected home (NYC only). The Current Name 
and Current CD fields are always protected. 

• The New Name and New CD fields are blank. 
• If there is a pending Home License or Home Closure 

for the selected FAD home, the Case (Stage) 
Name/CD window is view-only. 

• If there is a pending Home Name Change, the 
following message displays: 
 
“Saving will invalidate the Pending approval. 
Continue in Modify Mode?” 
 
If you click on the No button, the window displays in 
View-only mode; if you click on the Yes button, the 
window displays in Modify mode. 

Event List View-only • The Current Name field displays the current 
case/stage/home name before the Home Name 
Change was submitted for approval. 

• The New Name field displays the new 
case/stage/home name that was submitted for 
approval at the time the Home Name Change event 
was created. 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled. 

“Approve 
Home Name 
Change” 
Task 
To-Do 

View-only • The Current Name field displays the current 
case/stage/home name before the Home Name 
Change was submitted for approval. 

• The New Name field displays the new 
case/stage/home name that was submitted for 
approval at the time the Home Name Change event 
was created. 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled. 

Continued on next page
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Case (Stage) Name/CD Window 
Display Variations 

Path/ 
Window 

Display 
Mode 

Display 
Details 

Continued from previous page 

“Rejection 
Home Name 
Change” 
Task 
To-Do 

View-only 
or 

Modify 

• The Current Name field displays the current 
case/stage/home name for the selected FAD home. 

• The New Name field displays the case/stage/home 
name that was rejected after it was submitted for 
approval. 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled. 

• If currently there is a pending Home Name Change, 
the following message displays: 
 
 “Saving will invalidate the Pending approval. 
 Continue in Modify Mode?” 
 
If you click on the No button, the window displays in 
view-only mode; if you click on the Yes button, the 
window displays in Modify mode. 
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Case Summary 
The Case Summary window allows a worker to view summary information for a specific case. 
The Case Name displays in the title bar to identify the FAD home for which the case summary 
information applies. Information displayed in this window cannot be modified from within the 
window itself. 

Build 15 changes to the Case Summary window include the addition of four new columns: 

• Vendor ID and Case ID columns display at the far right of the window for FAD stages 
only. Use the horizontal scroll bar at the bottom of the window to view these columns. 

• A secondary assignment (SEC) column displays a check mark if any current or historical 
secondary workers are assigned to the stage. 

• A Community District (CD) column has been added for FAD workers in New York City. 
Workers outside New York City will see the column, but it will be blank. 
 

As has always been the case, the ability to view information in the Case Summary window is 
influenced by a number of factors, including the kind of stage for which information is being 
accessed and the security attributes assigned to the worker (see “Appendix A” on page 52 for 
details). 

To Access the Case Summary Window: 

1. From the Case List: Select a case on the Case List, then click on the Summary 
button (or click on the Options menu and select the Case Summary… command). 

2. From the Assigned Workload: Select a stage on the Assigned Workload, then click 
on the Options menu and select the Case Summary… command. 

3. From the Assign window: Click on the Options menu and select the Case 
Summary… command. 
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Close Home 
FAD workers use the Close Home window to document the closure of foster or adoptive homes 
in CONNECTIONS. 

 
Build 15 includes a FAD Home Closure Report to support regulatory requirements. The report 
automatically populates some fields with data from the database and provides a narrative for 
FAD workers to use for documenting home closures. The report is accessed via the new 
Closure Report button on the Close Home window (see page 15 for detailed information about 
the FAD Home Closure Report). 

A Save and Submit button also has been added to the Close Home window. This button (along 
with the Save and Submit command in the File menu) is disabled until the Closure Report is 
accessed. 

To Access the Close Home Window from the Assigned Workload: 

1. Click on the home to select it from the Assigned Workload, then click on the Tasks… 
button to open the Task List. 

2. Click on the Close Home task, then click on either the New button (to record a new 
home closure event) or the Detail… button (to view a previously created home 
closure event) to open the Close Home window. 
 

If the current status of the home is “Pending Acceptance” and the associated licensing approval 
is pending, the Close Home window will not open; the following message displays: 

“A licensing change is pending approval. The home/facility cannot be closed.” 
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Close Home Window Display Variations 

Action Window Display 

Submitting a 
FAD home for 
closure 

The Current Status field is protected and populated from the 
database. 

The Change To field is protected. For FAD homes in Inquiry status, 
the field reads either “Closed” or “Closed — Duplicate;” for homes in 
any other status, the field reads “Pending Closure.” 

The following fields are enabled and blank: 
• Closure Reason—The worker must select a closure reason 

that best summarizes why the authorizing agency is closing 
the home. 

• Closure Type—This field has two choices, “Voluntary” or 
“Involuntary,” to categorize why the foster home is closing. 
“Involuntary” closure indicates that the authorizing agency is 
initiating the home closure. “Voluntary” closure indicates that 
the foster or adoptive parents are initiating the home closure. 

• Recommend Re-Opening—This field has two choices, 
“Recommend” and “Do Not Recommend,” to indicate whether 
the authorizing agency recommends that the home be re-
opened at a later date. This information is helpful to future 
FAD workers who may consider re-opening the home. 

• Date Notification Sent—The authorizing agency is required 
to notify foster or adoptive parents of the intent to close the 
home at least 20 days prior to closing the home. The worker 
uses this field to record the date on which the notification was 
sent. 

The Closure Report button is enabled. The Closure Report check 
box is disabled; once the Summary Closure Report has been 
accessed, an “x” displays in the check box. 

Changing a 
Pending 
Closure 

The Status field is protected and reads, “Pending Closure.” 

The Change To field is protected and populated from the database. 

The following fields are enabled† and populated from the database: 
 • Closure Reason • Closure Type 
 • Recommend Re-Opening • Date Notification Sent 

The Closure Report button is enabled; the check box is disabled. 
† Provided the worker clicks on the “Yes” button in response to the message, “Saving will invalidate the 

pending Approval. Continue in Modify mode?” Otherwise, these fields are protected. 

Continued on next page
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Close Home Window Display Variations 

Action Window Display 
Continued from previous page 

Viewing a FAD 
Home 
Submitted 
Closure Event 

The following fields are protected and populated from the database: 
 • Status 
 • Closure Reason • Closure Type 
 • Recommend Re-Opening • Date Notification Sent 

The Closure Report button is enabled. The Summary Closure 
Report is frozen and displays in View-only mode. 

 

 

FAD Home Closure Report 
OCFS regulations require detailed documentation regarding the closure of a foster home. Prior 
to Build 15, this information was documented in the external foster home case record. 

Build 15 provides support for documenting this information in CONNECTIONS. The new FAD 
Home Closure Report includes a narrative in which workers record the reasons for home 
closure, as well as basic home demographics and the home closure decision. The FAD Home 
Closure Report includes pre-filled case/facility identifiers to support regulatory requirements and 
automatically populates some fields with information from the database. The report is accessed 
via the Closure Report button on the Close Home window (for more information about the 
Close Home window, see page 13). Once the FAD Home Closure Report has been accessed, 
an “x” displays in the check box next to the Closure Report button. 

The FAD Home Closure Report automatically populates fields with information from the 
CONNECTIONS database each time the report is accessed. When the report is completed, the 
worker Saves and Submits the report for supervisory approval. Once the report is approved, it is 
“frozen” and displays in View-only mode. Multiple closure events for a home can be recorded in 
CONNECTIONS; each closure event has its own closure window. 

This Save and Submit button (along with the Save and Submit command in the File menu) on 
the Home Closure window is disabled until the Home Closure Report is accessed. 

Workers will continue to receive the following message when they Save and Submit a home 
closure for supervisory approval: 

“Have you completed the Closing Summary Report?” 
 

To Access the FAD Home Closure Report: 

1. Select a FAD stage from the Assigned Workload, then click on the Tasks… button to 
open the Task List. 

2. Click on the Close Home task, then click on the New button to open the Close 
Home window. 

CONNECTIONS - System Build 15 – FAD Job Aid (04/15/2002) Page 15 



 

3. Record information in the appropriate fields on this window. 
The information will be reflected in the report. 

4. Click on the Closure Report button to launch the report. 
 

F/A Home History Detail 
The F/A Home History Detail window is used to maintain historical records of FAD homes. This 
window is opened from the F/A Home History window, using the History Detail button. 

In order to modify the F/A Home History Detail window, the worker must have the “Maintain 
Historic F/A Home” security attribute. 

Only dates and status data about the selected FAD Home record can be modified; all other 
fields are protected. If the most recent record is selected from the F/A Home History window, 
only the date in the Authorized From field can be modified. 

To conform with regulatory requirements and to ensure that the certification dates do not 
exceed one year, Build 15 includes an edit that prevents an F/A Home history record from being 
modified until the home has progressed to Accepted-Active status at least once. 

The Save button (as well as the Save command from the File menu) enables when any change 
is made to these fields. 

When a home’s certification is back-dated (i.e., a change is made to the Authorized From field 
on the F/A Home History Detail window), the Authorized To field is modified accordingly, 
calculated to the number of days that the Authorized From field was changed. This update 
ensures that the one-year certification period is valid. This change applies only to the first F/A 
Home History record that is modified. All ensuing F/A Home History records are adjusted 
accordingly, but F/A Home History records prior to the changed record are not affected. 

To Open the F/A Home History Detail Window from the Assigned Workload: 

1. Click on a FAD home on the Assigned Workload and click on the Tasks… button to 
open the Task List. 

2. Select the View Home History task and click on the List… button to open the F/A 
Home History window. 

3. Select a FAD Home history record from the F/A Home History window and click on 
the History Detail… button to open the F/A Home History Detail window. 
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F/A Home License 
The F/A Home License window is used to record or view the licensing and status information for 
a FAD home. Workers Save and Submit licensing changes for supervisory approval from this 
window. 

The Home Study button and check box have been removed, since the new Home Study task 
has been added to the Task List as part of the FAD Record Summary (for more information 
about the FAD Record Summary, see the FRS Job Aid). 

The former LOC (Level of Care) field has been renamed Facility Type. 

A system edit has been added to the F/A Home License window to ensure a proper relationship 
between Setting and Program Type, in order to comply with policy requirements. If a selected 
Program Type does not correspond to the selected Setting, the following error message 
displays at the bottom of the window: 

“The Program Type selected is invalid for the setting.” 
 

The worker must correct this error in order to proceed. The table below lists appropriate 
Program Type and Setting relationships for FAD homes: 

Setting 
Program Type Foster 

Home Adoptive 

HIV + / AIDS   
Mother/Child   
Emergency   
Refugee Assistance Pgm   
Regular   
Hard to Place   
Supervised Independent Living Program†   
Maternity   
Diagnostic Reception Center†   

Sex Offenders†   
Therapeutic   
Special Needs Medical   
Special Needs Behavioral   

†These program types are appropriate only for facilities with a Setting of “Congregate.” 
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Three new check boxes have been added to the F/A Home License window. The Fingerprint 
Extension check box has been added to the new Renewal/Extension section (the pre-existing 
Reauthorization check box has been moved into this section) to enable workers to record a 90-
day fingerprint extension period for a FAD home (for more information about fingerprint 
extension periods, see “Home Certification/Approval Extensions” on page 42). The Medical 
Dates Complete and Fingerprint Results Complete check boxes have been added in the new 
Cert./Approval Requirements section and will be system-generated when these two regulatory 
requirements have been met if the data has been recorded on the Person Detail FA window. 

When the worker selects Save and Submit from the File menu, any in-process FAD Record 
Summary—Home Study event is bundled with the Home License submission. Any in-process 
FAD Record Summary—Annual Reauthorization event is bundled with the Home License 
submission only if the Reauthorization check box is selected on the F/A Home License window 
(for information regarding the FAD Record Summary, see the FAD Record Summary Job Aid). 

A new home event is generated whenever the F/A Home License window is Saved and 
Submitted. When the worker Saves and Submits the F/A Home License window, if the most 
recent pending home event is either a pending Home Name Change or a pending Home 
Address Change, the event is not invalidated. 

When the worker tries to Save and Submit the F/A Home License window, the system verifies 
that the Marital Status, Date of Birth (DOB), Ethnicity, Gender, Religion and Language fields 
have been recorded on the Person Detail window for each principal in the FAD home. If any of 
this information not recorded, the following error message displays: 

“<Field Name> is required for all persons in the home.” 
 
 

This message is in addition to current system functionality, which verifies that at least one 
principal is identified as a foster parent in the Rel/Int field on the Person Detail window; if no 
principals are recorded with the Relationship/Interest code of “Foster Parent,” the following error 
message displays: 
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“The home must have at least one foster parent identified.” 
 

When multiple error messages are generated, a Message List displays with all applicable error 
messages, rather than individual message windows. 

 
If a secondary worker Saves and Submits the F/A Home License window for approval, an Alert 
To-Do is sent to the Case To-Do List and to the primary worker’s Staff To-Do List. The 
Description column of the To-Do List contains the following text: 

“F/A home license sub. for approval by secondary worker - <Resource ID>” 
 

For information regarding Build 15 changes for Emergency Homes, see page 42. 

To Access the F/A Home License Window: 

1. Select a FAD stage from the Assigned Workload and click on the Tasks… button to 
open the Task List. 

2. Select the Maintain Licensing Information task and click on the Detail… button to 
open the F/A Home License window. 
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F/A Home List 
The F/A Home List displays the results of an F/A Home Search (see page 43 for information 
about the F/A Home Search function). 

 
The Home Demo. (Demographics) button has been added to the F/A Home List to provide 
access to the Home Demographics window for an existing foster home. Prior to Build 15, this 
window was opened only via the Home Demographics command in the Options menu on the 
F/A Home List. A home must be selected from the F/A Home List in order to enable the Home 
Demo. button. 

Conducting an effective search is key to determining if a FAD home already exists in 
CONNECTIONS. The Build 15 enhancements to the F/A Home Search functionality support this 
process. If a worker does not enter a home name on the F/A Home Search window, the New 
button disables on the resulting F/A Home List and the worker is not able to create a new home. 
This feature helps preserve system data integrity. 

The build also incorporates system edits to protect the Home Name field on the Home 
Demographics window to preserve system data integrity. When a worker conducts an F/A Home 
Search and clicks on the New button to create a new foster home, the Home Name entered in 
the search criteria is carried over to the Home Demographics window. As a result, the entire 
foster home name should be entered in the Home Name field when conducting the F/A Home 
Search (for more information about changes to F/A Home Search, see page 43). 

To support federal reporting requirements, the Ethnicity field has been modified to display as a 
combination of Ethnicity and Hispanic or Latino Origin. If more than one origin is recorded, 
“Hispanic or Latino Origin — Multiple” displays in this column (see page 24 for a list of available 
Hispanic or Latino origins that can be recorded in CONNECTIONS). The individually selected 
origins still display on the Home Demographics window. 
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Five new columns have been added to the F/A Home List: 

Vendor ID A Vendor ID (VID) is a unique eight-digit number that must be 
recorded for each FAD home in order for the home to receive 
reimbursement. The VID is recorded as part of the business 
address in the Home Demographics window. 

Sub-Agency 
(NYC only) 

Specific office sites in New York City (agency code A66) are 
classified further into sub-agencies; workers can search and sort 
FAD homes in CONNECTIONS by sub-agency. 

When a foster or adoptive home is created in CONNECTIONS by a 
New York City ACS worker (agency code A66) or transferred to a 
primary worker who is from agency A66, CONNECTIONS 
automatically populates the New York City “800” level sub-agency 
information in the F/A Home List. A foster or adoptive home in New 
York City can be associated with one of these sub-agencies. This 
field is always protected. 

Foster or adoptive homes that are created outside of New York 
City, as well as homes that are transferred to a primary worker 
whose agency code is not A66, will not display sub-agency 
information. 

Race If a single racial selection is recorded, that selection displays in this 
column. If multiple racial selections are recorded, “Multiple” 
displays in this column (see page 23 for a list of available races 
that can be recorded in CONNECTIONS). 

CD 
(NYC only) 

New York City addresses are organized into geographical 
subdivisions called Community Districts (CDs). The CD displays as 
a two-digit code. 

This column lists the Community District in which the FAD home 
(or the household involved in a CPS stage) is located. Information 
displays in this column only for homes and individuals with New 
York City addresses. 

 

Case ID The Case ID number is a unique, system-generated, 8-digit 
number automatically assigned to each case in CONNECTIONS, 
including FAD homes. 

 

The columns on the F/A Home List have been reordered to reduce the amount of scrolling 
required to see pertinent information. The new order of the columns is: 

Resource Name | Vendor ID | Setting | Status | Sub-Agency | Ethnicity | Race | Addr 1 | 
City | County | State | CD | ZIP Code | Worker Name | Worker’s Phone Number | 
Worker’s Phone Extension | Case ID 
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To Access the F/A Home List: 

1. Click on the Options menu on the CONNECTIONS Toolbar and select the F/A 
Home command. 

2. Select F/A Home Search… from the resulting sub-menu to open the F/A Home 
Search window. 

3. Conduct a search (see “F/A Home Search” on page 43 for details on searching for 
FAD homes). When the search is complete, the F/A Home List displays the search 
results. 

 

Home Demographics 
The Home Demographics window is used by FAD workers to record, maintain and view 
demographic information about a FAD home. 

 
The Home Demographics window has been changed significantly to help streamline the FAD 
home recording process. More information is available and modifiable on this window, which 
reduces the number of associated windows that need to be opened in order to complete FAD 
recording activities. 

The title bar displays the Home Name, Resource ID and Case ID when the window is opened in 
View-only or Modify mode (when the window is opened in New mode, “New” still displays next 
to window name in the title bar). 

When the Home Demographics window is opened by clicking on the New button on the F/A 
Home List, the Home Name, Setting, Language, Address and County fields default to the 
values entered in the search criteria on the F/A Home Search window. 

The Resource ID field has been removed from the Home Demographics window, since this 
information now displays in the title bar. 
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The Source of Inquiry field has been renamed Inquiry Source. The Marital Status field has 
been renamed Marital. 

New federal standards require that a more accurate representation of race and ethnicity be 
captured for federal reporting. These standards include the ability to record multiple races for a 
single person and redefine ethnicity categories previously used in federal reporting. To conform 
to these new standards, three new fields have been added to the Home Demographics window: 
Race, Ethnicity and Hispanic or Latino Origin.  

Implementation of Build 15 includes a data fix that will be run in CONNECTIONS to convert the 
ethnicity information in existing FAD home records to the new standard. The conversion is 
detailed in the following table: 

Post-Conversion 
Current 

Ethnicity Latino 
Origin Race 

AA African-American Non-Latino - Black or African American 
Black or African American 

AC African-American/Caucasian Non-Latino - 
White 

AH African-American/Hispanic Latino - Black or African American 
AN Native American/Alaskan Native Non-Latino - American Indian 

Asian 
AP Asian/Pacific Is/Caucasian Non-Latino - 

White 
AS Asian/Pacific Is/Oriental Non-Latino - Asian 
BO Black/Other Non-Latino - Black or African-American 
CW Caucasian (White/Non-Hispanic) Non-Latino - White 
HC Hispanic/Caucasian Latino - White 
HL Hispanic/Latino/PR Latino - White 
HO Hispanic/Oriental Latino - Asian 

Black or African American 
NA Native African Non-Latino - 

Native African 
Asian 

OB Oriental/Black Non-Latino - 
Black or African American 

UN Unable to Determine - - Not Reported 

XX Unknown - - Not Reported 
(Intake stages only) 

 

The Race field contains a list of races and sub-groups that can be recorded in CONNECTIONS. 
More than one race can be selected from the list. Available races are: 

• Black or African 
American 

• Alaskan Native 

• American Indian 

• Asian 

• White 

• Native 
Hawaiian/Pacific 
Islander 

• Multiple 

CONNECTIONS - System Build 15 – FAD Job Aid (04/15/2002) Page 23 



 

Available race sub-groups that can be recorded in CONNECTIONS are described in the table 
below: 

Race (or Race Sub-Group) Code 
Black or African American AA 
 Caribbean AAC 
 Haitian AAH 
 Native African AAN 
 Other – Black or African American AAX 
Alaskan Native AL 
American Indian AM 
Asian AS 
 Chinese ASC 
 Indian ASI 
 Japanese ASJ 
 Korean ASK 
 Other – Asian ASX 
Pacific Islander/Native Hawaiian PI 
White WH 

 

Double-click a race to select it from the list. A check mark displays to the left of each selected 
race. Remember, more than one race can be selected from the list. To deselect a race, double-
click it again and the check mark no longer displays. 

The Ethnicity field contains a drop-down list with two options: 

• Hispanic or Latino 

• Non-Hispanic or Latino 
 

To select an option, click on the drop-down arrow for the Ethnicity field and click to select from 
the resulting list. Only one option can be selected. 

The Hispanic or Latino Origin field contains a list of Hispanic or Latino origins that can be 
recorded in CONNECTIONS. Multiple origins can be selected. Available origins are: 

• Central American 

• Caribbean 

• Cuban 

• Dominican 

• Mexican 

• North American 

• Puerto Rican 

• South American 

• Other 
 
Double-click an origin to select it from the list. A check mark displays to the left of each selected 
origin. Remember, more than one origin can be selected from the list. To deselect an origin, 
double-click it again and the check mark no longer displays. 
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The value in the Ethnicity field must be  “Hispanic or Latino” in order for the Hispanic or 
Latino Origin field to enable. 

The Community District (CD) field has been added to the Home Demographics window. This 
field displays a two-digit code based on the address information recorded for the home. 
Community Districts represent geographical subdivisions within the five boroughs; they display 
only for New York City addresses. 

A Save and Assign button has been added to the Home Demographics window, providing an 
alternative to using the Save and Assign command from the File menu (the command remains 
in the File menu for workers who prefer to use this method). The Save and Assign button (and 
menu command) enable only when the window is in New mode. 

For most FAD homes, the Resource (Home) Name is the same as its Legal Name. Sometimes 
the Legal Name of a FAD Home is different than the Resource Name in the database. The 
Legal Name field has been added to the F/A Home Demographics window to enable workers to 
record a Legal Name that is different from the Resource Name. If the two names are the same, 
the system defaults the Legal Name to the data in the Home Name field when the home is 
Saved and Assigned. 

The Primary Address and Primary Phone group boxes have been added to the F/A Home 
Demographics window to reduce the amount of system navigation required for data entry in the 
FAD recording process. This information is modifiable only on the Home Demographics window. 
To add other addresses or phone numbers, use the Address button (to open the Resource 
Address List) or the Phone button (to open the Resource Phone List). 

 
A new Use as Business check box has been added to enable workers to record the business 
address (when it is the same as the primary address) without navigating to additional windows. 
This check box also protects the business address on the Resource Address Detail window. 
This functionality ensures that valid address information is transmitted to BICS for payment 
purposes. 

Build 15 includes a system edit that requires address validation before a worker can Save and 
Assign (or Save and Submit) the FAD home. Otherwise, the following error message displays: 

CONNECTIONS - System Build 15 – FAD Job Aid (04/15/2002) Page 25 



 

“The address must be validated before you leave this window.” 
 

This feature helps preserve system data integrity by ensuring that all addresses recorded in 
CONNECTIONS are validated through CODE-1 to comply with US Postal Service address 
formatting standards. 

Required address fields on the Home Demographics window are: Street, City, State, County 
and ZIP Code. This helps ensure that proper address information is recorded in the system; that 
address information is sent to BICS for payment purposes. 

When a home’s primary or business address is changed and submitted for supervisory 
approval, CONNECTIONS sends an Alert To-Do to the primary worker’s Staff To-Do List. The 
text of the To-Do reads: 

“Update Home Study/Reauthorization RE: Address/Name change.” 
 

The Home Name field is protected and defaulted on the Home Demographics window for all 
FAD homes. The field also is protected when maintaining an existing home. Information in 
protected fields cannot be changed on this window (to correct the home name, see “Case 
(Stage) Name/CD” on page 7). Protecting this field supports the preservation of system data 
integrity. Due to this change in CONNECTIONS FAD functionality, the entire foster home name 
should be entered in the Home Name field when conducting the F/A Home Search (for more 
information about enhancements to F/A Home Search, see page 43). 

When a worker Saves and Assigns a new FAD home and clicks on the Save button, the Save 
command (File menu), the Cancel button, or the Exit command (File menu) in the Assign 
window, all windows in the FAD dialog close. This feature improves the efficiency of the 
recording process by eliminating the need to close each window individually. 

Supervisory approval is required when changing the Home Name, Primary Address or Business 
Address for a FAD home that is in Accepted-Active or Emergency status. If the worker attempts 
to save such changes under these circumstances by clicking on the Save button, the following 
message displays: 

“Supervisor approval is required for this action. Select Save and Submit.” 
 

Saving and Submitting generates a Task To-Do for the approver, who navigates directly from 
the Task To-Do to the Resource Address Detail window. An approval event also generates on 
the Event List whenever the Home Demographics window is Saved and Submitted. 

If the pending approval is rejected, the home event status changes to “REJT.” If the pending 
approval is rejected, the home event status changes to “REJT.” When a primary and/or 
business address has been approved, the primary address of everyone in the home is updated 
automatically to the primary address of the home, unless a person is found in an open CPS 
stage. If the supervisor rejects an address change, the home’s original address information will 
be restored to the last approved value. 

If a worker navigates to the Home Demographics window when a Home License or Home 
Closure pending approval event exists, the following message displays: 

“Saving will invalidate the pending approval. Continue in modify mode?” 
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Clicking on the Yes button opens the window in Modify mode. If the worker changes any of the 
information on the window and saves the changes, the pending approval event is invalidated 
and the worker needs to resubmit the approval item to the supervisor. Clicking on the No button 
opens the window in View-only mode. 

A system edit on the Home Demographics window prevents the worker from leaving the Vendor 
ID field blank when saving information for a home that is in Accepted-Active or Emergency 
status. This edit ensures that BICS receives a valid Vendor ID for payment purposes. 

 

Resource Address Detail 
Prior to Build 15, workers used the Resource Address Detail window to record all addresses 
(primary address and business address) for a FAD home. With the implementation of Build 15, 
the primary address is recorded directly on the Home Demographics window, as is the business 
address when it is the same as the primary address (see page 22). 

When the business address for a FAD home is different than the primary address, the worker 
records the business address in the Resource Address Detail window. When the primary and 
business addresses are identical, the primary and business address information is protected in 
this window. When the two addresses are different, the primary address is protected in this 
window. 

The following fields are required when recording a business address in the Resource Address 
Detail window: 

• Street 1 
• City 

• State 
• County 

• ZIP Code 

 
Completing these required fields helps ensure that proper address information is recorded for 
the foster home in CONNECTIONS. This information is used for system-generated certificates 
and letters and is transmitted to BICS during the nightly batch update. 

 

Resource Phone Detail 
The Resource Phone Detail window enables workers to record, maintain and view phone 
number information for a FAD home. 

Prior to Build 15, workers used this window to record all phone numbers for a FAD home. With 
the implementation of Build 15, the primary phone number is recorded directly on the Home 
Demographics window. The Resource Phone Detail window is used only for recording additional 
phone numbers for the FAD home. The primary phone number is modifiable only on the Home 
Demographics window; it is protected on the Resource Phone Detail window. 
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Person Detail 
The Person Detail window is used to view, update or add information about individuals in FAD 
homes. It enables workers to add principals to the CONNECTIONS database or relate 
individuals already in the database to a FAD home. 

 
The Occupation and Living Arrangement fields have been removed from the Person Detail 
window. If this information was recorded for a person prior to Build 15, it remains in the 
database. 

Three new fields (Race, Ethnicity and Hispanic or Latino Origin) have been added to the 
Person Detail  window to support new federal reporting standards for race and ethnicity. These 
standards include the ability to collect multiple races for a single person and also redefine 
ethnicity categories previously used in federal reporting. 

The implementation of Build 15 includes running a data fix in CONNECTIONS to convert the 
ethnicity information in existing person records to the new standard. Individuals listed as 
“Unknown” or “Unable to Determine” in the Ethnicity field prior to Build 15 will be converted to 
“Not Reported” in the new Race and Ethnicity fields (see the table on page 23 for information 
regarding the conversion). 

The Race field contains a list of races that can be recorded in CONNECTIONS. More than one 
race can be selected from the list (see page 23 for a list of available races). Double-click a race 
to select it from the list. A check mark displays to the left of each selected race. To deselect a 
race, double-click it again and the check mark no longer displays. 

The Ethnicity field contains a drop-down list with two options: 

• Hispanic or Latino 

• Non-Hispanic or Latino 
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To select an option, click on the drop-down arrow for the Ethnicity field and click on one of the 
options from the resulting list. Only one option can be selected. 

The value in the Ethnicity field must be “Hispanic or Latino” in order for the Hispanic or Latino 
Origin field to enable. 

The Hispanic or Latino Origin field contains a list of Hispanic or Latino origins that can be 
recorded in CONNECTIONS. Multiple origins can be selected (see page 24 for a list of available 
origins). Double-click an origin to select it from the list. A check mark displays to the left of each 
selected origin. To deselect an origin, double-click it again and the check mark no longer 
displays. 

Group boxes for Primary Address and Phone information have been added to the Person Detail 
window to help streamline the FAD recording process, enabling workers to record most of the 
required person information on one window. The Address… and Phone… buttons are still 
enabled so workers can record other addresses and phone numbers for a person. To record 
information in the Person Detail FA window or the Home Member Training List/Detail window, 
workers still need to use the Options menu on the Person List. 

The Options menu on the Person Detail window has been modified to include six commands 
previously available only from the Options menu on the Person List (these commands also 
remain accessible from the Person List): 

• Person Events 
• Case List 

• A.K.A. Name 
List/Detail 

• Person Identifiers 

• Address 
List/Detail 

• Phone List/Detail 

 
These commands enable workers to navigate to the associated windows without having to 
return to the Person List. 

The Type field on the Person Detail window defaults to PRN (principal) for all new persons 
added or related to a FAD home. 

Prior to Build 15, FAD workers had to maintain address and phone information for a FAD home 
by navigating to additional windows. Address and phone information for individuals in the home 
had to be maintained separately and individually. 
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With the implementation of Build 15, when the primary address or phone for a FAD home is 
changed in the Home Demographics window and approved, the primary address and phone 
information for all principals in the home is updated accordingly, except for persons found in 
open CPS stages. If the home is in Inquiry or Applicant status, the change is reflected once the 
change is Saved. 

When a FAD home is re-opened, the primary address and phone number for the principals 
default to those of the home, except for individuals found in an open CPS stage. 

When a new person is added to a FAD home, that person’s primary address and phone number 
default to those recorded for the home, unless the person is found in an open CPS stage. 

If a person being related to a FAD stage is found in an open CPS stage and the person’s 
primary address and phone number are different from those of the home, the following message 
displays: 

“Addr/Ph does not match Home Addr/Ph. Contact worker(s) of open stage(s).” 
 

The FAD worker needs to contact the worker assigned to the open CPS stage to resolve 
discrepancies in the primary address/phone. 

The implementation of Build 15 includes running a data fix to add and/or update address and 
phone information for principals who are in open FAD stages but not in any open CPS stages. 

Build 15 includes a system edit to verify that the Marital Status, DOB, Ethnicity, Gender, 
Religion and Language fields are recorded for each principal. If any of this information is 
missing when the worker attempts to Save and Submit the home for supervisory approval, an 
error message displays. 

This change is in addition to the current system edit that ensures at least one principal in the 
FAD home is identified with a code of “Foster Parent” in the Relationship/Interest (Rel/Int) field 
on the Person Detail window. If a foster parent is not identified, the following message displays 
when the worker tries to Save and Submit the F/A Home License window for approval: 

“The home must have at least one foster parent identified.” 
 

Additional religions have been added to the drop-down list for the Religion field: 

• Baptist 

• Methodist 

• Lutheran 

• Episcopal 

• Mormon 

• Other Christian 

• Hindu 

• Buddhist 

• Other Asian Religion 
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Changes to Common Functions 

Approval Status 
The Approval Status window enables a supervisor to approve or reject work that has been 
submitted by a worker. This window also allows workers to view the status of work they have 
submitted for approval. 

Prior to Build 15, workers received an Alert To-Do on the Staff To-Do List when a submitted 
item was rejected by the supervisor, but the Alert did not specify what had been rejected and 
the worker could not navigate directly from the To-Do to the required window. Workers were 
required to check the Approval Status window to view a rejection and the accompanying 
supervisory comments. 

Build 15 creates a system-generated Task To-Do for rejections. This To-Do displays on the 
Staff To-Do List and Case To-Do List once a rejection has been logged by the supervisor. The 
Description column for the To-Do contains the following text: 

“<Event title> - Rejection logged.” 
 

The worker can view the supervisor’s comments on the To-Do Detail window by selecting the 
Task To-Do and clicking on the Detail… button. The comments display in the 
Description/Notes field. By clicking on the Navigate… button on the To-Do List for the same 
To-Do, the worker can navigate directly to the task-related window to correct the required 
item(s) and resubmit the work for approval. 

 

Assigned Workload 
Build 15 includes two significant changes to the Assigned Workload: 

• A Refresh button has been added to bottom of the Assigned Workload (previously, 
workers had to select the Refresh command from the Options menu on the Assigned 
Workload). The Refresh button returns the display of assignments on the Assigned 
Workload to the default sort and adds any new assignments received since the last time 
the Assigned Workload was opened or refreshed. 

• A new command in the Options menu, Workload Filter, opens the Assigned Workload 
(Filtered) window. This new window enables workers to view a sub-set of assignments 
from the Assigned Workload, which can make it easier for workers to navigate through 
large workloads. Workers can filter by Stage ID, Case ID and Match Retrieved by 
Stage Name. A minimum of two characters of the stage name must be entered in the 
Match Retrieved by Stage Name field to enable that particular filter. When the 
Assigned Workload has been filtered, the title bar reads: 

Assigned Workload - <worker’s name> (Filtered). 
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To remove the filter, click on the Refresh button on the Assigned Workload. 

 

Event List 

 
Build 15 adds two new dates for each event on the Event List to provide clarification to workers 
while viewing case events.  

The Event Date column displays the date on which an event was completed, as recorded on 
the specific window or during the event’s evaluation. If no date was recorded, the Event Date 
column for that event remains blank. 

The TX Date column displays the system transaction date, which represents the date an event 
is updated by a worker using one of the save functions (Save, Save and Stay, Save and Submit, 
Save and Close) on the specific event’s window. For events that are not generated via a save 
function (e.g., generation of an Approval Letter for an approved relative foster home), the 
system transaction date corresponds to the date the event was created. 

The Sort menu includes new commands for sorting the Event List, in ascending or descending 
order, by either of these new dates. 
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List Assignments Made 
The Options menu on the Assigned Workload contains a new command, List Assignments 
Made, which provides access to the new List Assignments Made window. Workers use this 
window to view assignments they have made to other workers and to retract assignments that 
were made in error. 

 
The List Assignments Made window only displays stages that have not been accessed by the 
assignee. If all of the stages have been accessed, the following message displays: 

“No Assignments to Retrieve. All Assignments Retrieved by Assigned Worker.” 
 

An assignment is considered “accessed” when it is selected from the Assigned Workload and 
either an Options menu command is selected or the Tasks… button is clicked. In order to 
retract an assignment, the affected stage must not yet have been accessed by the assignee. 

To retract an assignment that was made in error: 

3. Click on the Options menu on the Assigned Workload and select the List Assignments 
Made command to open the List Assignments Made window. 

4. Select the assignment to be retracted and click on the Assign button to open the 
Assign window. 

5. Reassign the stage to the correct worker by selecting the appropriate staff person’s 
name from the Available Staff list at the top of the Assign window and clicking on the 
Primary or Secondary button, as applicable. 

6. Click on the Save button. 
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When the retraction is completed successfully, the stage is removed from the original 
assignee’s Assigned Workload. The original assignee and his/her supervisor receive an Alert 
To-Do on the Staff To-Do List: 

“Stage #### was reassigned by <worker name>.” 

 

 

Streamlining of the FAD Home Recording and Maintenance Process 

Reduced Window Navigation 
Many windows in the FAD dialog have been modified to enable the recording of more 
information in a window, reducing the need to navigate to other windows to complete the 
recording process. 

Build 15 also closes every window in the FAD dialog when the worker Saves and Assigns a new 
FAD home. 

Reduced Duplicative Data Entry 
When the primary address or phone number for a FAD home is changed in the Home 
Demographics window and approved, CONNECTIONS automatically updates the primary 
address and phone number for all principals in the home, except for persons found in open CPS 
stages. If the home is in Inquiry or Applicant status, the update is reflected once the change is 
Saved. 

When a FAD home is reopened, the primary address and phone number for the principals 
defaults to those of the home, except for individuals found in an open CPS stage. 

When a new person is added to a FAD home, that person’s primary address and phone number 
default to those recorded for the home, unless the person is found in an open CPS stage. If a 
person being added to a FAD stage is found in an open CPS stage and the person’s primary 
address and phone number are different from those of the home, the following message 
displays: 

“Address/Phone does not match Home Address/Phone” 

The FAD worker then needs to contact the assigned CPS caseworker to resolve address or 
phone discrepancies.  

FAD Record Summary (FRS) 
The FAD Record Summary (FRS) provides a comprehensive view of all recorded information for 
a FAD home in one convenient place. A single, multi-tabbed window enables workers to access, 
view and print FAD home information easily. The window is organized to be consistent with the 
foster/adoptive home development process. 

The FRS also provides the ability for authorized workers to record Home Study and Annual 
Reauthorization narratives directly in the FRS, as well as comments and contact notes. The 
FRS includes an updateable FAD checklist to assist workers in verifying that all tasks necessary 
for proper certification/approval of FAD homes are completed. 
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The FRS reduces the duplicative entry of casework information in external documents and 
CONNECTIONS. This results in a more complete online record for each home and an 
improvement in the quality of case record documentation for FAD homes. 

For more information about the FRS, see the Foster and Adoptive Home Record Summary 
(FRS) Job Aid. 
 

Removing a Person from a FAD Stage 

Prior to Build 15, when a worker wanted to record that a person was no longer living in a FAD 
home, the worker would end-date that person’s primary address on the Address List/Detail 
window. The person would still display on the Person List for the home. This procedure was 
necessary to preserve an accurate historical record of the person in the home. 

Build 15 incorporates two new commands (Remove Person – Left Home and Remove Person 
– Added in Error) in the Options menu of the Person List to record this information, which 
preserves an accurate history of the FAD home and the individual in CONNECTIONS. 

 
The Remove Person – Left Home function removes an individual from a FAD home, but keeps 
the person’s record in the database and preserves an historical record of that individual in the 
home. The Remove Person – Added in Error function removes an individual from the home, 
but does not provide an historical record of the individual’s involvement with the home. 
Individuals who are removed via the Remove Person – Added in Error functionality are 
purged from the database after 90 days, if they are not associated with any other cases. 

When an historical record exists for a principal in a FAD home, the following message displays 
on the Person List: 

“Historical records exist.” 
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Remove Person – Left Home 
The Remove Person – Left Home function enables a worker to record that an individual left a 
FAD home, removing that individual from the Person List while preserving the historical record 
of that person in the FAD home. Home history reports and historical foster home certificates will 
include individuals who were living in the FAD home, as applicable. 

To Remove a Person Who Has Left a Foster Home: 

1. Select the affected FAD home/stage from the Assigned Workload and click on the 
Tasks… button to open the Task List. 

2. Click on the Maintain Person task and click on the List… button to open the Person 
List. 

3. Click on the name of the person to be removed from the home. 

4. Click on the Options menu and select the Remove Person – Left Home command. 
The following message displays: 
 

“Are you sure you want to Remove Person – Left Home?” 
 

4. Click on the Yes button to remove the person from the FAD stage. Click on the No 
button to cancel the Remove Person – Left Home function. 

 

Remove Person – Added in Error 
The Remove Person – Added in Error function enables a worker to remove an individual who 
was added or related to a FAD home/stage in error. When the worker completes the Remove 
Person – Added in Error function, the misrelated person is removed from the FAD home/stage 
and the individual does not retain an historical association with the FAD home. A Remove 
Person – Added in Error event is created and includes an event description indicating the 
Person ID (PID) that was removed from the stage: 

“<PID> was removed from stage.” 
 

The following Alert To-Do also is generated to all workers who are assigned to an open stage 
involving the removed person: 

“<Name> (<PID>) was removed from <Stage Name> (<Stage ID>).” 

The step-by-step procedure for removing a person who was added in error is similar to the 
instructions for “Remove Person – Left Home” on page 36, but the worker selects the Remove 
Person – Added in Error command from the Options menu in Step 4. In order to perform this 
function, the worker must have the new “Remove Person – Added in Error” security attribute. In 
addition, the worker must: 

• have an assigned role in the FAD stage, or 

• be in the primary worker’s unit hierarchy. 
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In order to maintain accurate data for the person, the worker is responsible for making 
necessary demographic changes prior to performing the Remove Person – Added in Error 
function. If changes have been made to person information since the person was related, the 
following message displays: 

“Changes made to person in this stage should be reset before continuing. 

For example, if the person’s age information was changed from 45 to 35 years after being 
added to the stage, the age must be corrected to reflect the original information before the 
individual can be removed from the stage. 

If no changes have been made or if demographic information has been reset or if the person 
was added (not related) to the stage, the following message displays: 

“Are you sure you want to Remove Person – Added in Error?” 
 

 

Person Merge and Person Split 
In your work with CONNECTIONS, you may encounter multiple 
records for the same person, or records for two separate 
persons that have been accidentally combined into one. 

Duplicate records can be created if a worker misses a potential 
match during a Person Search; the worker adds the new person 
record, rather than relating an existing person record in the 
system. The opposite situation—accidentally combined 
records—can result if a worker merges records for two 
individuals who seem to be the same person, but actually are 
not. 

In order to maintain data integrity and prevent problems with 
accurate case management, duplicate and accidentally combined person records are corrected 
in CONNECTIONS with the Person Merge and Person Split functions. A Person Merge joins 
two separate Person IDs into the same record; a Person Split separates person records that 
were merged in error. 

 
The individual responsible for 

merging and splitting is subject 
to local agency policy and 

procedure. This task may not 
fall under the scope of the 

individual caseworker’s 
responsibilities. 

A specific Business 
Function Profile will now 
be required in order to 

perform a merge or split. 

Build 15 includes several enhancements to the Person Merge and Person Split functions. In 
addition to the Person Merge/Split window, these changes also are reflected in other windows. 
The M column on the Person List has been changed to M/S. This column continues to indicate 
that a person has been involved in a merge or split. A new column in the Case Composition 
window, M/S, has been added to indicate when a person has been involved in a merge or split.  

Once a merge has been completed, the Person Closed no longer displays on the Case 
Composition window. 
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Person Merge 

With the implementation of Build 15, once a person merge is completed, the Person Forward 
(the person who is carried forward to further stages) replaces the Person Closed (the person 
who is merged) in all non-intake stages (open and closed) and events. 

Another enhancement introduced with Build 15 is the creation of the Person Forward Selection 
window. This new window enables workers to select specific person information to be applied to 
the Person Forward.  

 
 

Clicking on the Merge button on the Person/Merge Split window opens the Person Forward 
Selection window. 

The following information displays on the Person Forward Selection window for both the Person 
Forward and the Person Closed:  

• Full Primary Name 
• Sex 
• Ethnicity 

• Race 
• Marital Status 
• DOB (including 

Approximate indicator) 

• DOD (including reason and 
Approximate indicator) 

• Primary Address 
• Primary Phone 

 

Information can be selected from either person by clicking on the corresponding radio button. 
The information retained for the Person Forward is determined by the type of information 
selected and the person from whom that information is selected. 

If a worker selects information (e.g., Name) from the Person Forward, the primary information 
for the Person Closed is end-dated and copied to the Person Forward. 
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If the worker selects information from the Person Closed, the primary information for the Person 
Forward is end-dated and the information from the Person Closed is copied as the primary 
record. 

Some information is not part of the selection process on the Person Forward Selection window. 
For example, starting with Build 15, information regarding a person’s Occupation and Living 
Arrangement will no longer be recorded. The Occupation and Living Arrangement fields have 
been removed from the Person Detail window. However, if this information was recorded for a 
person prior to Build 15, it will still be maintained in the database. When a Person Merge is 
complete, the Person Forward’s information is retained for 
Occupation and Living Arrangement. This information also 
displays in the Person Data Report. 

 
Because of the complexity 
involved with restoring this 
information, merges should 

be completed with care. 

Valid Person Identifiers, Person Detail FA Home, Language and 
Religion information also are retained from the Person Forward, 
unless the field is blank. If the Person Forward does not have 
this information recorded, the information from the Person 
Closed is copied to the Person Forward. 

Person Split 
A Person Split is performed when the records for two separate persons were accidentally 
merged into one. Performing a Person Split reinstates the Person Closed to the database, but 
does not return the Person Closed to his or her original stages, events or allegations. The 
records for these individuals must be restored carefully for each stage and event. 

After a Person Split is performed, the information for the Person Closed can be accessed 
through the Person Detail window when conducting a Person Search. Person Detail information 
that existed for the Person Closed prior to the merge is restored. The worker must update all 
demographic information and “return” the Person Closed to all appropriate stages and events. 
The worker can use the Maintain Person task to restore the Person Closed to open stages. If 
the stage is closed, the worker can request a data fix through the Help Desk or use Local Data 
Maintenance when it is available in the future. The worker also must remove the Person 
Forward by performing the Remove Person – Added in Error function (see page 36 for details 
about this function). 

As part of the implementation of Build 15, an initial data fix will be run to update information in 
the database. This data fix will be run only once and will update the Person Closed with the 
Person Forward for all non-Intake closed stages and events for Person Merges that occurred 
prior to Build 15. 

A second data fix will be run only when requested by a worker. This second data fix returns the 
Person Forward to all appropriate stages and events that existed prior to the merge. 

Historical Information 

Historical Person List 
Build 15 introduces the new Historical Person List, which displays all individuals removed from a 
specific FAD home because they left the home. In order for these individuals to display on the 
Historical Person List, the worker must use the Remove Person – Left Home function (see 
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page 36). Individuals who were removed from a FAD home because they were Added in Error 
(Remove Person – Added in Error function) do not display on the Historical Person List. 

 
With the implementation of Build 15, the Options menu on the Person List includes a new 
Historical Person List command, which opens the Historical Person List. This new window 
displays all of the individuals removed from a specific FAD stage, including the date on which 
each person was removed. The “View FAD” security attribute is required to enable this 
command. 

If a person is involved in a merge, the Historical Person List displays the Person Forward 
information; if the person is involved in a split, the original name displays with the original 
information prior to the merge. 

Case List 
The introduction of the Remove Person – Left Home function affects the information that 
displays on the Case List when a person is removed from a FAD home via this function. 

The Case List enables the worker to view a list of cases which either meet the search criteria 
entered in the Case Search window or are associated with a person searched for using the 
Person Search function. The Case List displays high-level case information, such as the Case 
name, Case ID, the local district or voluntary agency responsible for the FAD home and the 
primary worker assigned to the most recent open stage of the case. 

Prior to Build 15, the Case List did not indicate whether an individual was associated with a FAD 
case. Only current and historical CPS cases and current FAD cases displayed. Build 15 
modifies the Case List to display historical case involvement for the person on whom the search 
was conducted. 
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When the Case List is opened via the Person Search window, the Person List or the Person 
Detail window, the historical FAD cases are shaded in gray and the following message displays 
if the person is no longer in the FAD home: 

“Shaded rows represent historical involvement in FAD stages.” 
 

To Access the Case List from the Person Search Window: 

1. Access the Person Search window: 
⇒ Local districts only: Click on the PERS button on the CONNECTIONS Toolbar. 

 
OR 
 

⇒ Local districts and voluntary agencies: Click on a FAD home from the Assigned 
Workload and click on the Tasks… button to open the Task List. Select the 
Maintain Person task and click on the List… button to open the Person List. 
Click on the New button on the Person List to open the Person Search window. 
 

2. Enter search criteria and click on the Search button. Search results display in the 
Person Search List in the lower half of the Person Search window. 

3. Click on a name to select it from the Person Search List. 

4. Click on the Options menu and select the Case List… command. 
 

To Access the Case List from the Person List: 

1. Click on a FAD home from the Assigned Workload and click on the Tasks… button 
to open the Task List. 

2. Select the Maintain Person task and click on the List… button to open the Person 
List. 

3. Click on the Options menu and select the Case List… command. 
 

To Access the Case List from the Person Detail Window: 

1. Click on a FAD home on the Assigned Workload and click on the Tasks… button to 
open the Task List. 

2. Select the Maintain Person task and click on the List… button to open the Person 
List.  

3. Select a person from the Person List and click on the Detail… button to open the 
Person Detail window.  

4. Click on the View Options menu on the Person Detail window and select View 
Case List… to open the Case List. 
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Effects of Historical Persons on Foster Home Certificates and Approval Letters 
The Remove Person – Left Home function described in the previous section affects the 
historical record of a FAD home, including certificates and approval letters. 

When an individual is removed from a FAD home with the Remove Person – Left Home 
function, the historical certificate or approval letter retains that person’s name in a “frozen” 
historical document. This helps ensure that the historical home certificate or approval letter 
reflects accurate information for the historical period represented by that document. 

Certificates and approval letters generated after an individual has been removed from the FAD 
home via the Remove Person – Left Home function do not show the person as a member of 
the foster home. 

 

Changes for FAD Homes in Emergency Status 

Prior to Build 15, a foster home could be progressed to a status of “Emergency” for a maximum 
of 60 days. To support regulatory requirements, Build 15 increases Emergency status to 90 
days and includes a system edit to ensure that a home being progressed to Emergency status 
has a Facility Type of “Certified Foster Home” or “Approved Relative Foster Home.” 

Once a home has been fully certified (progressed to Accepted-Active status), it cannot revert to 
Emergency status; the home must be closed and re-opened in order for it to enter Emergency 
status again. 

Prior to Build 15, when an Emergency home progressed to Accepted-Active status, the date in 
the Authorized From field reflected the end of the 60-day Emergency status period, regardless 
of when the progression was approved by the supervisor. With the implementation of Build 15, 
when a home progresses from Emergency status to Accepted-Active status, the date in the 
Authorized From field reflects the date of the supervisory approval. The date in the Authorized 
To field is one year after the date in the Authorized From field. 

 

Home Certification/Approval Extensions 

Build 15 enables FAD workers to record 90-day Fingerprint extension periods in 
CONNECTIONS when all regulatory requirements for home certification or approval have been 
met and the only item outstanding is the receipt of the fingerprinting results. Extension periods 
are recorded on the F/A Home License window (see page 17). 

A home in Accepted-Active status may be recertified or reapproved for four (4) 90-day periods 
while fingerprinting results are pending. Since this involves extending the certification of a home 
that has already been progressed to Accepted-Active status, IV-E reimbursement is not 
affected. 

A home in Emergency status may be extended for three (3) 90-day periods for a “year” (360 
days) total. Homes in Emergency status are not IV-E reimbursable. 

Regulatory requirements and the status of the foster home determine the ability to record these 
extension periods in CONNECTIONS: 

CONNECTIONS - System Build 15 – FAD Job Aid (04/15/2002) Page 42 



 

Home Status 

Emergency Accepted-Active 
• Limit of three 90-day extensions. • Limit of four 90-day extensions. 

• Valid medical must be on file. • Valid medical must be on file. 
• Fingerprint extensions are allowed 

only if the Date Card Sent field on 
the Person Detail FA window has 
been recorded for all principals 
age 18 and older. 

• Each time the Emergency period 
is extended, the Authorized To 
date increases by 90 days; the 
Authorized From date is 
unchanged. 

• When the first extension is 
requested, the new Authorized 
From date will be set to the 
current Authorized To date; the 
new Authorized To date will be 
90 days from the new Authorized 
From date. 

• Fingerprint extensions are allowed 
only if the Date Card Sent field on 
the Person Detail FA window has 
been recorded for all principals 
age 18 and older and the Date 
Results Received field is empty 
for at least one principal. 

• When the second or third 
extension is requested, the 
Authorized From date is 
unchanged; the Authorized To 
date is increased by 90 days. 

• The fingerprint extension period 
can’t be extended more than 30 
days prior to the Authorized To 
date. 

• If a home is in an extension period 
and the worker attempts to 
reauthorize the home for one year, 
the Authorized From date is 
unchanged; the Authorized To 
date will be one (1) year from the 
Authorized From date. 

 

 

 

Changes to Search Functionality 

F/A Home Search 
The F/A Home Search window enables workers to search for FAD homes in CONNECTIONS. 
The system performs the search (based on the criteria entered) and displays all FAD homes 
that match the search criteria in the F/A Home List (for more information about the F/A Home 
List, see page 20). 
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The F/A Home Search function searches exclusively for foster homes in CONNECTIONS, 
regardless of home status (unless the worker enters search criteria in the Status field). This 
differs from the Resource Search function, which searches the entire Resource Directory based 
on the search criteria entered in the Resource Search Criteria window. 

Due to the legal implications involved with searching for FAD homes based on ethnicity (and the 
change in federal definitions and recording standards), the Ethnicity field has been removed 
from the F/A Home Search window. 

A new Search Type field has been added to the F/A Home Search window. This field contains 
a drop-down list with three search options: 
 

Phonetic 
Name 
(default) 

Returns results that sound like the criteria entered in the Home Name field. 

All of the fields are enabled, but search criteria must be entered in the 
Home Name field to initiate a Phonetic Name search. If search criteria are 
entered in any of the Identifier fields (Resource ID, Case ID or Vendor ID), 
all other fields disable and the search type changes automatically to Exact. 
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Phonetic 
Address 

Returns results that sound like the information entered in the Address 
section (the Street 1 field is required to enable a Phonetic Address search). 

When the Phonetic Address search type is selected, all non-address fields 
disable. All address fields are enabled, but search criteria must be entered 
in the Street 1 field to initiate a Phonetic Address Search. 

 
NOTE: 

See the tip box on page 46 and the table on page 46 
for details about using the Phonetic Address search type. 

 

  

Exact Returns results that match the search criteria character for character and 
space for space. 

When this search type is selected, all fields enable once the pre-filled 
Agency code is cleared, but the search is not initiated until search criteria 
are entered in one of the required fields: 

 • Resource ID 
• Case ID 
• Vendor ID 

• Agency ID 
• Home Name 
• Street 1 

• City 
• County 
• NYC Sub-Agency 

 

If search criteria are entered in one of the identifier fields (Resource ID, Case ID or Vendor ID), 
all other fields disable and the Exact search uses only the entered identifier in the search. If 
search criteria are entered in a non-identifier field, the identifier fields disable and are not 
considered in the search. 

All F/A Home Search results return based on the search type and search criteria entered, 
regardless of the search type. There is no pre-set limit on search results. 

Prior to Build 15, address searches were exact and only returned results that matched the 
search criteria character for character and space for space. Build 15 introduces a new, more 
effective method of searching for addresses in CONNECTIONS. A new search type, Phonetic 
Address, increases the pool of potential matches by including search results based on partial 
address information. The Phonetic Address search type also affects how results are scored and 
displayed, the way data is identified and the manner in which you enter search criteria (see the 
table and tip box on page 46 for details). 

When a worker selects the Phonetic Address search type, the Street 1 field highlights in yellow, 
indicating that it is a required field. All non-address fields (e.g., First Name, DOB) disable. 

CONNECTIONS creates a pool of candidates (search results) by comparing the phonetic 
similarity of the search criteria entered in the Street 1 field with the information in the Street 1 
field of an address recorded in the database. All other address search criteria (e.g., City) are 
used to score the candidates. The closer the Street 1 candidate information is to the Street 1 
search criteria, the higher the candidate’s score will be. 
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Search Results: 
Scoring vs. Filtering 

Result Description Search 
Type(s) 

Scoring Phonetic searches are 
“scored” by any and all 
additional search criteria 
that are entered. Scoring 
ranks candidates in the 
pool of results depending 
on how close they are to 
the search criteria. 

Phonetic 
Name 

Phonetic 
Address 
(see tip box 
at right) 

Filtering Exact searches are 
“filtered” by any and all 
additional search criteria 
entered. Filtering 
eliminates candidates 
from the pool of results. 

Exact 

Phonetic 
Address 
(see tip box 
at right) 

 

Phonetic Address searches may 
be scored and filtered, depending 

on the search criteria. 

Entering search criteria in additional 
address fields scores the search 

results. The closer a result is 
to all of the search criteria, 

the higher its score. 

Entering additional information in 
the Street 1 field filters the search 

results. For example, entering 
“Willow” in the Street 1 field—

without a house number or suffix 
(e.g., “Avenue”)—returns all results 
with Willow (or street names similar 

to Willow) in the Street 1 field. 

In this example, addresses across 
New York State that match the 

Street 1 field would return higher on 
the list of results. Addresses 

containing street numbers or a suffix 
(as well as street names that are 
phonetically similar to the street 
name in the search criteria) will 

display lower on the list. 

It is advisable to conduct a Phonetic 
Address search using only the 
street name (without a house 

number or suffix) in the Street 1 
field. This reduces the likelihood of 

filtering out a valid match. 

 

Other address fields can be used in conjunction with the 
Street 1 field to affect the ranking of the search results. For 
example, if the worker enters search criteria in the City 
field, addresses that match the Street 1 field and the City 
field receive a higher score in the search results than those 
which match the Street 1 field but do not match the City. 

If the worker includes the number with the street name (e.g., 
“10 Willow”), all matches with that number and street name 
will return on the result list. In some instances, a number or 
street name that is phonetically similar to the search criteria 
will also return in the search results. 

The table on the following page provides examples of 
possible Phonetic Address search results. 



 

 

A Phonetic Address Search using the 
following criteria: 

Street 1 City 

Produces the following results: 

Willow Apple City • Willow, Apple City 

• Willow, Beachville 

• Willow, Chippertown 

• 5 Willow, Apple City 

• 5 Willow, Beachville 

• 63 Willow, Beachville 
The results in this example would 
continue with all matches that are 
phonetically similar to the Street 1 
search criteria. 

5 Willow Apple City • 5 Willow, Apple City 

• 5 Willow, Beachville 

• 5 Willson, Beachville 

• 5 Willout, Chippertown 
The results in this example would all 
have “5” in the Street 1 field. House 
number greatly influences the 
search results.  

 

Build 15 also enables workers to use CODE-1 address validation for information entered in the 
Address section of the F/A Home Search window. CODE-1 formats the address to comply with 
US Postal Service standards. This feature enables workers to search using address search 
criteria that comply with the standard for address information recorded in the database. This 
results in a greater likelihood of finding and returning address matches. Since they should 
intentionally be broad, Phonetic Address searches should not be validated via CODE-1. 

To Perform a Phonetic Address Search (F/A Home Search): 

1. Click on the drop-down arrow for the Search Type field on the F/A Home Search 
window and select Phonetic Address from the resulting list. 

2. Enter the street name in the Street 1 field. 

3. Enter other known information in the remaining address fields (e.g., City, County). 

4. Click on the Search button. 
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Search results display on the F/A Home List. If no records match the search criteria, the 
following message displays at the bottom of the F/A Home List: 

“The criteria entered results in no information being returned.” 
 

Resource Search 
The Resource Search Criteria window enables workers to search for resources in the 
CONNECTIONS Resource Directory, often referred to as the “Yellow Pages of 
CONNECTIONS.” Several changes have been made to the Resource Search function to enable 
workers to search for resources more effectively. 

The following nine (9) fields are enabled when the Resource Search Criteria window is opened: 

• Search Type 
• Resource Name 
• Agency ID 

• Resource Type 
• Inactive check box 

• Transportation 
check box (not used) 

• Resource ID 
• Case ID 
• Vendor ID 

All other fields enable or disable depending on the criteria entered in these nine fields. 

 
A new Search Type field has been added to the Resource Search Criteria window. This field 
contains a drop-down list with three search options: 

Phonetic Name 
(default) 

Returns results that sound like the information entered in the 
Resource Name field. 

Phonetic 
Address 

Returns results that sound like the information entered in the 
Address section (the Street 1 field is required to enable a 
Phonetic Address search). See the tip box and table on page 
46 for more information about Phonetic Address search. 

Exact/Directory Returns results that exactly match the search criteria. 
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CONNECTIONS returns all results that match the search type and search criteria, regardless of 
which search type is selected. There is no pre-set limit on the number of results that return (see 
page 46 for detailed information regarding search results). 

Build 15 also includes capability for using CODE-1 address validation for FAD home addresses 
entered in the Resource Search Criteria window. CODE-1 formats the address to comply with 
US Postal Service standards. This feature enables workers to search using address search 
criteria that comply with the standard for address information recorded in the database. This 
results in a greater likelihood of finding and returning address matches. 

To Perform a Phonetic Address Search (Resource Search): 

1. Click on the drop-down arrow for the Search Type field on the Resource Search 
Criteria window and select Phonetic Address from the resulting list. 

2. Enter the street name in the Street 1 field. 

3. Enter other known information in the remaining address fields (e.g., City, County). 

4. Click on the Search button. 
 

Search results display on the Resource List. If no records match the search criteria, the 
following message displays instead of the Resource List: 

“No matches were found for these search parameters.” 
 

The Resource List displays resources in CONNECTIONS that match the information entered in 
the Resource Search Criteria window. Build 15 reorders the columns in the Resource List to 
reduce the need for scrolling to view pertinent information. The new column order is as follows: 

Resource Name | Vendor ID | Facility Type/LOC | Status | Authorized By | Maintainer | 
Sub-Agency | Street 1 | City | County | Community District | Phone | Extension | Rsrc Type 
| Resource ID | Agency ID | FAD Facility | Last Update By | Case ID | District/Voluntary 
Agency | Contracted 

 

Person Search 
Prior to Build 15, address criteria were considered exactly in Person Search—results displayed 
only if they matched the address criteria character for character and space for space. 

Build 15 adds Phonetic Address search capability to the Person Search function. Phonetic 
Address search increases searching capabilities by allowing reasonably accurate matching on 
partially correct address information. 

The Search Type field in the Person Search window now contains three options in its drop-
down list: 

• Phonetic Name • Phonetic Address • Exact 
 
Person Search defaults to the Phonetic Name search type. 
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This change affects the manner in which person search results are scored and displayed, the 
way data is identified and the way workers enter search criteria. Phonetic Address search 
displays results at the top of the Person Search List that most closely match the search criteria, 
followed by less similar matches (see the tip box on page 46 and the table on page 46 for more 
information about the Phonetic Address search function). 

Fields that are required to enable a particular type of Person Search are highlighted in yellow, 
while fields that are unavailable for a selected search type are disabled. 

To Perform a Phonetic Address Search (Person Search): 

1. Click on the drop-down arrow for the Search Type field on the Person Search 
window and select Phonetic Address from the resulting list. 

 

Be sure to review the entire list 
of search results for possible 
matches. Street addresses 
(e.g., Willow, 5 Willow, 18 

Willow) from the same city will 
not score the same and may 

display lower in the list of results. 
Use the scroll bar to proceed 

through the list. 

When the  (page up/page 
down) buttons enable, there are 
more results on the list. Click on 
the page up/page down button, 

as applicable, to view the 
remaining search results. 

2. Enter the street name in the Street 1 field. 

3. Enter other known information in the remaining 
address fields (e.g., City, County). 

4. Click on the Search button. 
 

Search results display on the Person Search List at the 
bottom of the Person Search window and the Person 
Search List title bar displays the following message: 

“Phonetic Address Results Returned.” 

If no records match the search criteria, the following 
message displays in the Person Search List title bar: 

“No Results Returned.” 

The Match column on the Person Search List displays 
“ADDR,” indicating that a Phonetic Address search was 
performed. 

Local Data Maintenance 

Additional enhancements to the CONNECTIONS system are scheduled for implementation in 
the summer of 2002, including the introduction of the Local Data Maintenance (LDM) window. 
This single, multi-tabbed window enables workers to view and update person demographic 
information for closed FAD homes. For example, a person’s demographic information might 
have been recorded incorrectly or may need to be revised. Presently, updating information for a 
closed FAD Home requires re-opening the home and navigating through a series of windows to 
make the necessary changes. 

A new security attribute, “Maintain Closed Person Demographics,” will provide access to Local 
Data Maintenance functions for FAD homes. 
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New System-Generated To-Do’s 

To-Do Type 
(A=Alert; T=Task) Description 

A 
To the primary worker when a secondary worker Saves and 
Submits the Home Demographics or Case (Stage) Name/CD 
window for approval. 

A To the Unit Approver if a worker Saves and Submits an item to 
anyone other than the Unit Approver. 

A To the primary worker when s/he Saves and Submits a home 
name or address change for approval. 

A To the primary worker when a submitted name and/or address 
change is approved. 

A 
To the primary worker when Saving and Submitting name or 
address changes; informs the worker that these changes 
require the completion of a Home Study update. 

A 
To the primary worker when a FAD Record Summary event is 
approved; reminds the worker to print a copy of the F/A Home 
Certificate or Approval Letter for the foster parents. 

T To the primary worker when a submitted name and/or address 
change is rejected.  

T To the supervisor when the Case (Stage) Name/CD window is 
Saved and Submitted. 

T 
To the supervisor when the Home Name, Primary Address or 
Business Address is changed in the Home Demographics 
window and the window is Saved and Submitted. 

 

Updates to Online Help 

Build 15 continues the development of the CONNECTIONS Online Help system. Online Help 
has been updated to reflect enhancements made to the CONNECTIONS system as a result of 
Build 15. These enhancements include new and modified windows and fields, as well as 
changes to casework recording guidelines. 
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Appendix A: 
Security Attributes and Case Summary Information 

The ability to view information in the Case Summary window is influenced by a number of 
factors, including the kind of stage for which information is being accessed and the security 
attributes assigned to the worker. 

To view… A worker must have this 
security attribute… 

Without the required 
security attribute… 

Details of a FAD stage Maintain FAD The Summary… button (as well as 
the Summary… command in the 
Options menu) disables and the 
worker is not able to open the Case 
Summary window. 

Information for an 
unfounded CPS 
investigation 

View Unfounded The Case Summary window 
displays, but unfounded investigation 
information does not display on the 
window. 

Details in an indicated 
CPS investigation 

View Indicated Indicated Investigations (and their 
associated Intake stages) display on 
the Case Summary window, but the 
worker is not able to navigate to any 
of the details of the Investigation 
stage(s) or the associated Intake 
stage(s). 

Details in an open 
CPS investigation 

View Under Investigation Open Investigations (and their 
associated Intake stages) display on 
the Case Summary window, but the 
worker is not able to navigate to any 
of the details of the Investigation 
stage(s) or the associated Intake 
stage(s). 

Details in an ARI 
(Administrative 
Review) stage 

View Admin Review The Case Summary window opens, 
but the worker is not able to view any 
details (e.g., Person List, Event List). 

Case Summary 
window from the Case 
List for a sensitive 
case 

View Sensitive The Summary… button (as well as 
the Summary… command in the 
Options menu) disables and the 
worker is not able to open the Case 
Summary window. 
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